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Experiment 14:  A Kinetic Study of the "Breathalyzer" 
Reaction 

 

Objective:  In this experiment, you will study the kinetics of the reaction of ethanol and 
acidic potassium dichromate to determine whether the reaction is zero, first or second 
order with respect to dichromate concentration and to determine the rate constant of the 
reaction.  

Introduction 

 In the 1960's, as concern over the increasing number of injuries and fatalities 
caused by drunken drivers began to rise, chemists looked toward the development of 
simple screening tests that could be used by police officers to determine the level of 
alcohol in the blood of a car operator.  Drinking alcohol, referred to by chemists as 
ethanol, has the following chemical structure: 
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It can react with a variety of oxidizing agents to produce the compound acetaldehyde, 
which has the structure shown: 
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One oxidizing agent that will accomplish this transformation is potassium dichromate, 
K2Cr2O7.  (See Tro, pp 928-932, for further discussion regarding alcohols and 
aldehydes.) 

 Potassium dichromate produces a yellow solution when dissolved in acid.  As an 
acidic solution of dichromate reacts with ethanol, the Cr(VI) species is reduced to a 
Cr(III) species, which is green in aqueous solution.  The overall reaction is as follows: 

  3 CH3CH2OH   +   Cr2O72–  +  8 H+   →   3 CH3C(O)H  +  2 Cr3+ +  7 H2O (1) 
 yellow green 

Because the reaction is accompanied by this dramatic color change, it is possible to 
monitor it spectrophotometrically. 

 In a "Breathalyzer", a portable instrument used by the police to test alcohol levels 
in the blood, the breath is passed through an ampoule that contains an aqueous solution of 
K2Cr2O7 and sulfuric acid.  Alcohol contained in the breath is then oxidized to 
acetaldehyde while the chromium in the ampoule is reduced to the Cr(III) species.  Light 
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of the appropriate wavelength (440 nm) is passed through the ampoule and compared to a 
reference solution that contains only acidic potassium dichromate.  The absorbance 
difference between the two solutions is then interpreted to give the percent of ethanol 
contained in the blood. 

 The color change associated with the oxidation of ethanol also provides a 
convenient means for studying the kinetics, or rate, of the reaction (see Tro, Chapter 13, 
especially pp 564-581).  The complete rate equation for reaction (1) has the form: 
 Eq. 1 

where k is the rate constant, t is the time, the quantities in brackets indicate concen-
tration of the reactants, and the values for x, y and z must be determined experimentally.  
However, under conditions where the concentrations of ethanol and acid are large (and 
therefore remain approximately constant throughout the reaction), the rate equation 
reduces to: 

 Eq. 2 
The objective of this experiment is to determine whether x = 0, 1 or 2; that is, whether the 
rate law is zero, first or second order with respect to dichromate. 

 Let us examine each case individually.  If we let the initial concentration of 
dichromate ion equal a, and the concentration of dichromate which will have reacted at 
time t equal c, then the concentration of dichromate that remains at t is equal to (a – c).  
The rate equation becomes: 

 
 Eq. 3 
For a zero order reaction, x = 0 and the rate equation reduces to:  

 Eq. 4 
Integrating, we obtain: 

 c  = kt Eq. 5 

In this case, a plot of concentration, c, versus time, t, will produce a straight line with the 
slope equal to the rate constant, k. 

 For a first order reaction, x = 1 and the rate equation is: 

  Eq. 6 
Integrating, we obtain: 
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 ln [a / (a – c)] = kt     Eq. 7 

Thus, a plot of ln [a / (a – c)] versus t will produce a straight line with a slope of k. 

 Finally, for a second order reaction, x = 2 and the rate equation is: 

  Eq. 8 
Integrating, we obtain: 

 1/ (a – c) = kt + 1/a     Eq. 9 

 In this case, a plot of 1/(a – c) versus t will give a straight line with a slope of k 
and a y-intercept of 1/a. 

 In order to determine the quantities a and c, we must convert the absorbance of 
the solution at a wavelength of 440 nm to the concentration of dichromate ion in solution.  
Recall Beer's Law (see Experiment 6): 

 A0 = εal      Eq. 10 

where A0 = initial absorbance of the solution, a = initial concentration of dichromate ion,  
l= path length of the cell and ε = the molar absorptivity constant.  Rearranging equation 
10: 
 a = A0/εl      Eq. 11 

At time t, the equation becomes: 

 a – c = At/εl      Eq. 12 

where At is absorbance of the solution at time t.  Substituting equation 11 and 
rearranging: 
 c = (1/εl)(A0 – At)     Eq. 13 

 For the zero order reaction equation, making the appropriate substitution for c into 
equation 5 results in the following equation: 

  At = A0 – k(εl)t     Eq. 14 

A plot of At versus t will produce a straight line for a zero order reaction with the slope 
equal to -k(εl) and a y-intercept equal to A0. 

 To obtain the quantity a / (a – c) in terms of absorbance values for a first order 
reaction (equation 7), we must divide: 

 a/ (a – c) = (A0/εl)(ε l/At) = A0/At    

 ln (A0/(At ) = kt   or  

 ln At = ln A0 – kt      Eq. 15 
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Thus, a plot of ln(At) versus t will produce a line with a slope equal to –k  and a y-
intercept equal to ln(A0) for a first order reaction. 

 Lastly, substituting absorbance values into equation 9 gives: 

  1/At = (k/εl)t + 1/A0     Eq. 16 

where a plot of 1/At versus t gives a straight line with a slope equal to k/εl and a  
y-intercept of 1/A0 for a second order reaction. 

 A correction must be introduced at this point.  When the reaction reaches 
completion, at t = ∞, there will remain some absorbance of light at a wavelength of  
440 nm.  This residual absorbance, A∞, must be subtracted from each absorbance term in 
equations 14, 15 and 16: 

 (At  – A∞)= (A0 – A∞) – kεlt    Eq. 17 
  

 Eq. 18 

 Eq. 19 

Procedure (outline the steps of this section for your pre-lab assignment) 

 Two students will be assigned to work together to prepare one reaction solution.   
Each pair will be assigned to a specific spectrophotometer, which they must use to 
acquire all their measurements throughout the course of the experiment.     

 Set the wavelength of the Novaspec or Genesys 20 spectrophotometer at 440 nm.  
Fill a clean, dry cuvet with distilled water, and use this to "zero" the instrument (see 
TECH V).   

CAUTION:  Compounds that contain chromium (VI) are toxic and suspected 
carcinogens.  Wear gloves.  Wash your hands thoroughly with soap and water after 
handling solutions that contain Cr(VI).  Do not pour any solution containing 
chromium down the sink! 

 Using a volumetric pipet, transfer 5 mL of 0.0196 M potassium dichromate, 
K2Cr2O7, solution into a clean, dry 125 mL Erlenmeyer flask.  Add 50 mL of  
3.9 M sulfuric acid, H2SO4, to the flask using a graduated cylinder, and swirl the flask 
well to thoroughly mix the solution.   

 Fill a new clean, dry cuvet with this acidic dichromate solution.  Wipe off the 
outside of the cuvet with a Kimwipe so that is clean and dry, and place it in the 
spectrophotometer.  Record the absorbance of the acidic dichromate solution in your 
notebook (this is the initial absorbance, at t = 0).   
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 Remove the cuvet from the instrument, and pour the contents back into the 
Erlenmeyer flask.  Your instructor will add 0.13 mL of ethanol to the solution via 
syringe.  Note the time of addition of the ethanol (to the nearest second), and record it 
in your notebook.  Quickly and carefully swirl the solution, then rinse and fill the cuvet 
and return it to the Novaspec or Genesys 20.  Close the lid and record the absorbance of 
the solution along with the time.  Try to read the absorbance 60 seconds after the addition 
of ethanol. 

 Continue to take readings of the absorbance and the corresponding time at  
60 second intervals for 7 minutes total.  At the end of this time, remove the cuvet from 
the spectrophotometer, and allow it to stand undisturbed at room temperature for at least 
one hour.  You may proceed with the set-up of the spreadsheet for your data at this time. 

 Re-zero the spectrophotometer.  Return the cuvet containing the reaction mixture 
to the instrument and record the final absorbance value (A∞).  When you have completed 
the experiment, pour all solutions into the appropriate Laboratory Byproducts Jar. 

Data Work-up (you do not need to outline the steps of this section for your pre-lab 
assignment) 

 You will use the spreadsheet program Excel to analyze your data (see TECH 
IV.C).  To log onto the computer, click on “Student” and type “chemistry” for the 
password, then click on Log In.  Click on the Applications folder at the bottom of the 
screen.  In the window that opens, click on the button labeled Excel.  Under the View 
menu, make sure that Formula Builder has a check mark next to it.  You can begin by 
deciding what data you wish to include in the table.  You will need to plot three different 
graphs (or charts) in order to determine whether or not the reaction that you studied is 
zero, first or second order.  Let’s use the zero order case as an example to get you started. 

 In the case of a zero order reaction, we need to plot At -A∞ as a function of time, 
t, in order to obtain a straight line (see equation 17).  You can place your cursor in the 
first cell (A1) and type the word time with the units in parentheses, then press the return 
key.  In the cell below this (A2), you can type the first value for time, which is zero.  In 
the next cell down (A3), type the next value for time, which should be approximately 60 
seconds (if you did not take your first absorbance reading exactly one minute after the 
addition of ethanol, write down the exact time value).  Continue to enter the time values 
down column A. 

 You can label the next column (B) with the heading A(t), and then enter the 
absorbance values that correspond to the time values in the cells of column B.  We need 
to enter the value for the final absorbance reading, A∞, somewhere in the table.  Choose a 
cell that will not be used for any other data entries, such as A11, and type A(f) (for final 
absorbance reading, since the symbol ∞ is not available) in this cell.  In the next cell over 
(B11), type the value that you obtained for the final absorbance reading. [While you are 
waiting to obtain this value, type 0.05 as a “dummy” value in this cell for now.  You can 
change it later.]  Your table should look similar to the one shown at the top of the next 
page.   

We are now ready to define a column that will contain the values for At – Af.  
First, place a heading at the top of column C for this data, A(t) – A(f).  We will now 
define a function for each cell in column C so that the computer will calculate the value 
At – Af for us.  In cell C2 we would like the computer to subtract Af (located in cell B11) 
from the value for At, which is located in cell B2.  To do this, you could place the cursor  
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in cell C2 and type: 
=B2–B11 

 
A number would appear in cell C2 that corresponds to the first value for At minus the 
value for Af.  You could continue to define a similar function in each individual cell of 
column C (e.g. cell C3 would be:  =B3–B11). 

 Instead of typing a similar formula over and over, it is easier to use an array to 
define the whole column at once.  To do this, simply highlight all the cells that will be 
defined with a similar function (cells C2 through C9, in this case).  Then type: 

=B2:B9–$B$11 

Remember the equal sign!  The dollar signs that precede the letter and number in the 
above formula ensure that the address of this cell (B11) remains constant throughout the 
array.  Now hold down the command key (), and then press the return key, and the 
appropriate numbers should appear in all the highlighted cells.  (Array formulas must be 
locked in with the command-return keys.)  [Note:  To delete an array, all of the cells 
involved in the array must be highlighted, and then the command Clear is chosen from 
the Edit menu followed by pressing the command-return keys.] 

 You can complete the next columns on your own.  Decide what you need to plot 
in the cases of a first order reaction and a second order reaction (see equations 18 and 
19), and label the columns appropriately.  Then, define the necessary functions for the 
cells in those columns.  Be sure to save your data at some point.  It is a good idea to save 
the data periodically as you work on your spreadsheet.   
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Some hints:   
The value for A0 is contained in one of the cells of the table.  Which one? 
The command for obtaining the natural log of a value is simply LN followed by 

the argument in parentheses.  For example, if you wanted to take the natural log 
of a value in cell A1 you would type:  =LN(A1) 

The square brackets, [], should not be used when typing mathematical formulas in 
Excel.  Use parentheses— these can be nested several times.   

 Example: =(A1*(B1/(A2+B2))) 

Charts 

 To obtain a graph of your data, you need to highlight the cells in the first column 
(the time values).  Next, hold down the command key and highlight the cells in the 
column corresponding to the values necessary for a zero order plot (C2 to C9).  It is 
important that the column containing the x values (time) is highlighted first.  Do not 
highlight the text headings of the columns.  Once both columns are properly highlighted, 
pull down the Insert menu and choose Chart.  Click on the button XY (Scatter) from 
the row of Chart options, then click on the picture of data points without a line drawn 
through them.  A plot should appear on the spreadsheet.  Pull down the Chart menu and 
select Move Chart….  In the box, that appears, click in the circle next to “New sheet”, 
the click on OK.  The chart will now fill the screen as it appears on its own page.  Pull 
down the View menu and choose Formatting Palette.  Use the palette that appears to 
give your plot a title and to label the axes.  Be sure the Chart Options section of the 
Palette is visible (click on the triangle if it is not).  In the pull-down menu at the top of the 
Chart Options, choose Chart Title.  Click in the box underneath this menu and type in a 
title for your plot.  Next, change the Chart Title in the pull-down menu to Horizontal 
(Category) Axis.  Again, click in the box below and type a title for the x-axis.  Repeat the 
procedure for the Vertical (Value) Axis to type a title for the y-axis. 

You can add a “best fit” line by placing the cursor on a data point of the graph and 
clicking once.  All of the data points should now be highlighted.  Pull down the Chart 
menu and choose Add Trendline.  In the box that appears, click on Line from the list in 
the left-hand column.  Next, click on Options.  Click to put √’s in the boxes for “Display 
equation on chart” and “Display R-squared value on chart”, then click OK.  Print your 
graph by choosing Print from the File menu.  

 To get back to the worksheet, click on the tab at the bottom of the screen that says 
Sheet 1.  Use the same procedure to obtain plots and print-outs for the first and second 
order data as well.  Determine which plot produced the straightest line, and thus, whether 
the reaction is zero, first or second order.  

 If you have trouble deciding which plot produced the straightest line, you can 
look at the value for R2, which is displayed on the chart.  R is called the correlation 
coefficient and gives an indication of the “goodness” of fit of the data.  The closer the R2 
value is to 1.00, the better the data fit, or correlate, to a straight line.   

Once you have determined the order of the reaction rate, you can find the slope of 
this line and thus, the rate constant.  The slope of the line is found in the equation that is 
displayed on the chart.  Alternatively, you can use the LINEST function to perform a 
linear regression on the selected data and display the slope and the y-intercept on the 
worksheet.    

When you have completed the worksheet, save it and print it out by choosing 
Print under the File menu.  
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Calculations 

1.  Hand in the three plots (zero, first and second order) and the Excel worksheet 
of your data and results. 

2.  Is the reaction zero, first or second order with respect to dichromate? 

3.  What is the value of the rate constant?  What are the units?  Use the value  
3.58 x 102 M-1 for εl, if necessary. 

4.  Thermal decomposition of nitrosyl bromide to nitric oxide and bromine occurs 
according to the following reaction: 

2 NOBr   →   2 NO   +   Br2 

 The rate law is: 

  -d[NOBr]  =  k[NOBr]x 

  dt 

 The equations corresponding to the possible orders of the reaction follow: 

zero order:  [NOBr] = [NOBr]0 – kt 
first order:  ln([NOBr]0/[NOBr]) = kt 
second order:  1/[NOBr] = kt  +  1/[NOBr]0 

Use Excel to determine the order and rate constant of the reaction given the 
following data: 
 

Time (s) [NOBr] (M) 
0 0.150 

20 0.0759 
40 0.0494 
60 0.0380 
80 0.0306 
100 0.0244 
120 0.0214 

Note that in this problem you are given the concentration of NOBr (in 
molarity), not the absorbance of a solution of NOBr.  You do not need to use 
the Beer’s law relationship between absorbance and concentration to solve this 
problem.  Plot the "best fit" line.  Hand in the relevant plots and data tables.   

Questions 

1.  If you wished to alter the rate of the reaction of dichromate with ethanol, what 
changes could you make in the experimental conditions?  Name two. 

2.  Discuss the sources of error present in this experiment and how they would 
affect your results. 


